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6. Click Next to generate the A/R Cash Receipts by Check# report. 

7. If the batch is in balance and ready for posting, click Post. 
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Bill of Lading (BOL) Modifications (Spec 
5219)

Date Released: Jan 2017

Modules: Warehouse Reports Default Maintenance, Navigator Warehouse Shipping Reports

Description: Provides default settings that directs =the system to print special instructions and PO 
numbers on a VICS BOL. 

Reason for Change: Brings Navigator in-line with the DES (green screen). 

Restrictions: 

— Only VICs BOLs are affected by this change. 

— If there are multiple accounts with different message codes included on the BOL no special 
instructions are printed. 

Set-up

Navigator Warehouse Reports 

Customer Bill of Lading Defaults 

— Two settings were added: Print Special Instructions and Print Customer PO. 
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— This functionality only applies to VICS BOL. Codes 6 and 7 in the BOL form format setting. 

Path to the Default window: 

• Navigator: Warehouse Reports>Set Defaults>Customer or Transfer BOL. 

• DES (green screen): Warehouse Shipment Control Reports>F9 = Report Defaults

Message File (FIL 17)

The message printed on the VICS BOL is pulled in from the Messages File. The applicable messages 
are the 1 through 9 and A through Z “C”ustomer messages (C1-C9, CA-CZ). 
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Billto File 

Message codes are assigned in the Billto File. 

Note: In the DES (green screen), the Billto File is accessed via menu option FIL 1. 
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Special instructions from Item File to print 
on Selection Sheet (Spec 5229)

Date Released: Jan 2017

Modules: Selection Sheet Manager (SSM)

Description: This enhancements allows Special Instructions, from the Item File, to print on SSM 
sheets. The Special instructions are added to the printed document, under the item.

Reason for Change: Special Instructions can inform customers of special needs, in writing, for their 
selections, at the line level, before they actually purchase the material. 

Set-up

SSM Global and User settings (SSM 1 and SSM 2)

The setting Include Special Instructions, on screen 4, activates this functionality. 
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Item File

The special Instructions are pulled from the Item File. Messages flagged with a “Y” in the Ack 
column are included on the Selection Sheet. 

Path to the Special Instructions: 

• Navigator: File Management>Item File>Update or create an item>Select Instructions from the 
Options. 

• DES (green screen): FIL 2 - Item File>Update or create an item>F12 - Special Instructions.



February 27, 2017

Printing Special Instructions on a Selection Sheet

The option Include Special Instructions is now included among the Printing Options. 

Click Print to produce a PDF of the selection sheet that includes the special instructions. 
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SKU Costs now Included in Navigator Item 
Details Window (Spec 5207)

Status: Available in Navigator

Date Released: Jan 2017

Modules: Item Details Pop-up Window which is accessed from an item that has a hyper link.

Description: A SKU tab was added to the Item Detail window. This tab contains cost information 
such as: Average cost, Last Cost, and Freight Cost. 

Reason for Change: Creates one place for item costing information. Plus, the cost information is 
automatically updated. 

The Item Detail Pop-up can be accessed from any Navigator application that displays items; such as 
Order Management and Inventory. 

1. Click on the hyperlinked item to display the Item Options.

2. Select Item Details. 

On the Item Detail Information window, click SKU. 
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Note: The warehouse dropdown only includes warehouses that the user is authorized to view. The 
user control panel controls warehouse access. 

• Average Cost - The average unit cost of the onhand quantity for this SKU. A true weighted aver-
age is used. If this is a serial numbered item, then the average cost is for all serial numbers onhand 
in the warehouse and lot for this item. Do not confuse lot with serial number; multiple serial num-
bers can be in one lot number.

• Last Cost - The unit cost of the last receipt for the SKU. It is the last landed cost.

• Base Cost - The base (material) portion of the last cost.

• Freight Cost - The freight portion of the last cost.

• Stock/Non-Stock Override - Y (stock) or N (non-stock) comes from the Stock/Non-Stock Over-
ride field of the SKU File. 
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Suppressing Prices on COD Packing List 
(Spec 5239)

Status: Available in Navigator

Date Released: Jan/Feb 2017

Modules: Packing list printed from Navigator and DES (green screen)

Description: Implement a switch on the System Wide Setting - Packing List Consolidation & Print 
Options to suppress the printing of Prices. 

Reason for Change: Prior to this functionality, Dancik’s Packing List automatically included pricing. 
This functionality hides prices. This enhancement was developed for COD accounts who often send 
in their customers to pick up the products. 

Set-up

System Wide Setting - Packing List Consolidation & Print Options

The option Suppress printing Collect $ on Packing Lists activates this functionality. 

Printing Packing List

Packing lists can be printed from processed orders and from the warehouse shipping reports. 
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Processed Orders

Navigator - Follow this path to print a packing list for a processed order: Order 
Management>Available Options>Print.

DES - Menu option CUS 10>Enter a parameter>Select an Order>F10 to Print>F11 to print Packing 
List. 

Warehouse Shipping Reports

The functionality works with both Customer reports and Transfer reports.

Navigator - Select Warehouse Shipping Reports from the Navigator menu. 

DES - Menu option WAR 8>C6 or T6
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Example of Packing List with no Collect $ Displaying

Collect $ information appears here if this
functionality is not activated. 
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Hiding Message Lines with Cost/Price 
Information (Spec 5183)

Status: Available in Navigator and DES 

Date Released: Jan/Feb 2017

Modules: Navigator and DES Direct Ship PO

Description: A new message qualifier, “Z*”, directs the system to not show pricing information on 
Direct Ship POs. 

Reason for Change: Including the cost/price information, specifically freight, on Direct Ship POs 
allows the supplier to see it and possibly bill for it. 

Entering a Direct Ship Order with a Z* Message Line

1. Access Navigator Order Management and select Direct Ship Order. 

2. Enter the necessary information such as PO number and Supplier on the order header. 

3. On the order detail window, enter the items to order. 

4. Click the option arrow to the left of an item and select Message Lines. 
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5. Enter a message with Price and Cost information using the new Z* message qualifier. 

6. Click Update Lines and Charges to add the message line to the order. 
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7. Click Complete Order to produce a preview of the order that can be given to the customer that 
includes the charges added by the Z* message. 



Page 74 of 120February 27, 2017

8. Continue with the order to produce the Direct Ship PO document that is sent to the supplier which 
does not include the Z* message or the charges associated with it. 
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Scheduling and Distribution of Navigator 
Reports (Spec 5140)

Status: Available in Navigator 

Date Released: Feb 2017

Modules: Navigator Reports

Description: Update the Navigator Reports interface

Reason for Change: Adds the ability to schedule and distribute reports.

Scheduling and Distributing Reports in Navigator

1. Access the Navigator Reports Application. The Saved Reports window opens. We will get to the 
Saved Reports window a little later in this write-up. But first, we are going to build, schedule and 
save a report.

2. Click the icon in the upper left hand corner to expand menu.

3. Select a report to access its parameters. 

Each report has its own specific parameters. 

4. Enter the necessary parameters and click Next in the bottom right hand to work through all the 
report parameters. 

5. The last window for all of the reports allows you to confirm the report parameters.
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6. Click Save to save the report and all its parameter settings. 

Note: Click Run if you just want to generate the report and not save it. The report can be 
accessed by clicking ODS in the upper right hand corner and looking under Spoolfile 
Reports. 

7. Name the report and make it Public or Private. 

Only the person who created a Private report can access or edit it.

8. Click Save. The next dialog box allows you to schedule the report for automatic generation. 
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9. Clicking Yes takes you to the Schedule portion of the Reports. 

10. Click Edit to assign a generation Frequency and a Distribution List. 

11. Click Save. When the report is displayed in the Saved Reports window, it now has a clock icon to 
its left. 
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Note: The lock icon designates the report as a private report. 

Saved Reports

From the Saved Reports window you can:

— Access public reports 

— Access only your private reports

Note: Private reports are noted with a lock icon. 

— Inquire into and/or edit the report parameters

— Run the report

— Schedule a report for automatic generation,

— View a log of a report’s activity (when the report was created, when it was run, any changes to 
its scheduling, and any errors). 

Actions
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Open a saved report and click Actions in the top right hand corner. 

Run Now - Allows you to manually run the report. An entry is made in the report log. 

Run Now with Edits - Brings up the report parameter window where you can make changes. Any 
changes made are not saved. 

Copy - Keeps the report settings but allows you to save it under a new name and change the 
Public/Private setting. 

Delete - Deletes the report and removes it from the Saved Window display. 
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Using SKU Base Cost During PO Entry 
(Spec 5208)

Status: Available in Navigator 

Date Released: Jan/Feb 2017

Modules: Navigator and DES:

— Purchase order line entry

— Direct Ship order line entry

— Special order lines

Description: Use the last cost entered for that item/warehouse or the last cost from the SKU file as 
the default purchase order cost.

Reason for Change: Provides an auto-updating method to keep up with fluctuating prices. Provides 
an alternative method to having to manually update the Item File costs when a new price list is 
received. 

Restrictions (out of scope): 

— Stock to Stock transfer order

— customer orders 

— quotes 

— credit orders
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Set-up

SET 29 - System Table - ITEMPOLICY

The policy code LC was added. This policy code directs the system to use the SKU base cost on 
purchase orders, direct ship orders, and special orders. 
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Item File

Item Policy Codes are assigned in the Item File. 

Order Management 

1. If the order is a PO, Direct shipment, or an order line is for a special order line, the system checks 
the item’s policy code. 

2. If the Policy code is LC the SKU base cost is used. 
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Installation Manager (Spec 5062)
Status: Available in Navigator 

Date Released: Feb 2017

Modules: Navigator 

Description: Adds a new Installation Manager Application

Reason for Change: Provides Installation Managers a better way to schedule and maintain 
installations by warehouse and cost center. 

Set-up 

System Wide Setting - Options for Installation Applications 

This new Installation Manager Application is activated via option 3 - Installation Manager. 

Granting Access 

Access can be granted at the Global, Authority Class. or User level. 

Follow these paths to grant access at each level. 

Global Level

NAV 1>“A” in the Opt field for Installations>“Y” for both settings: Allow Access to Installation 
Manager Administrator Settings and Allow Access as an Installation Manager 

Authority Class

NAV 2> “W” in the Opt field of an Authority Class>“A” in the Opt field for Installations>“Y” for 
both settings: Allow Access to Installation Manager Administrator Settings and Allow Access as an 
Installation Manager 

User Level
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NAV 5 >“W” in the Opt field of a User>“A” in the Opt field for Installations>“Y” for both settings: 
Allow Access to Installation Manager Administrator Settings and Allow Access as an Installation 
Manager

Administration Panel

This “dashboard” provides the following to installation managers:

— ability to see jobs for all costs centers in one view

— ability to see jobs for all cost centers in one view 

— ability to schedule claims and inspections on the fly (without orders or in reference to closed 
orders)

— ability to change scheduled jobs on the fly

— review other installation manager crew schedules 

— store installation packet with print and email options

Access

The Admin Panel is accessed via the User’s drop down menu. 

Note: The user must have Installation Manager permissions at the user, authority class or global 
level. 

Automated Emails

Customer 

This section allows you configure emails that are automatically sent to customers during specific 
events of the installation cycle.

The email is sent to:

— For Retail customers - the email address assigned to the customer in the Retail Customer File.

— For Billto Customers - The first email record flagged to receive Acknowledgements in the 
Phone Number Maintenance portion of the Billto File. 
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— The Install Email on the Order Details window; if a value is entered.

Notification of Scheduled Job 

When an Installation Manager schedules a job for an Installer that belongs to his warehouse or 
receives approval to utilize an installer from another warehouse an email is to be sent to the customer.

Send Notification - Clicking Yes enables this email to be sent out automatically. 

Note: Enabled displays on the right hand side of the email listing if Send Notification is 
activated. 

Email Subject - Enter a subject for the email. A combination of free flow text and key words can be 
used. Keywords can be used to automatically add information to the email such as #ORDER- order 
number and #INDATE - Installation Date. 

Note: A list of all the available keywords is available by clicking the “?” icon. 
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Reminder of Scheduled Job 

Automated emails can be sent to remind a customer of an upcoming scheduled job.

The fields are the same as for the Notification of Scheduled Job except for the Send Schedule 
setting. The Send Schedule setting denotes how many days prior to the scheduled job a reminder 
email is to be sent. Multiple time frames can be selected. 

Post Installation Communication

After an install has been completed a follow up email can be sent to the customer.

Note: The setting are the same as for the Reminder of Scheduled Job email. 



February 27, 2017

Internal 

Job Calendar Email Schedule and Job Calendar Print Schedule - These options allow you to set 
up a day(s) and time that the job calendar can be emailed or printed. 

Note: For the Job Calendar Print Schedule option installations are only printed for the selected 
warehouse. 

Installation Manager Requests - These emails are to be sent when an installation manager requests 
an installer from a warehouse that he does not manage. 

Email Subject/Email Body - Enter a subject/body for the email. A combination of free flow text and 
key words can be used. Keywords can be used to automatically add information to the email such as 
#INSTALL- Installer and #INDATE - Installation Date. 

A list of all the available keywords is available by clicking the “?” icon. 
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General 

Cost Centers

The cost centers created here are the ones that are displayed in the Cost Center drop down menus 
throughout the Installation Manager application. 

Use a Color to help easily identify the cost center. A color can only be used once. 

Custom Values

This is where the values used in the Schedule and Log File are created. 

Add to Schedule - This field is found in the Schedule window activated via the Dashboard.
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Contact Log - Contact Type - Allows you create contact methods such as Email or home phone that 
are used in Call Log. 

Contact Log - Contact Method - Allows you create descriptions for contact methods such as spoke 
to on phone or emailed that are used in the Call Log.

Installation 

This part of the Administration Panel allows you to create and/or edit Installation Managers, Teams 
and Installers. 

Managers on page 90

Teams on page 91

Installers on page 92
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Managers

These are the only people who can schedule installations. 

Create a new manager record or edit an existing one. 

Setting Description

Installation Manager Select from a list of all the Navigator users on your system. 

Alternate 

An alternate means has access to the same Dashboard, Orders, etc., 
as the main manager. The alternate must switch to the other 
manager via the “Alternate” option in Installation Manager.

Select from a list of all the Navigator users on your system. 

Warehouse 
Cost Center

Select a warehouse/cost center combination that this Manager can 
schedule installations for. 

Only one warehouse can be selected per field. To enter more ise 
the Add Value feature. 

Multiple cost centers can be entered. 

In the example shown above, Installation manager Gbrannen can 
manage installations across All Warehouses for Carpet and 
Ceramic Tile. 

Customer Service Phone
Customer Service Email

Enter the customer-facing phone number and email address that a 
customer can contact if they have a question about their 
installation. 

The phone number and email address do not have to be the 
Installation Manager’s. They can be to someone else familiar with 
installations at the warehouse and cost center. 
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Teams

You can build teams based on things such as expertise or location. For example, you can create a 
carpet team or tile team composed of personnel skilled in installing those products.

Send backorder fill
email notification

Sends an email alerting the installation manager that an order on 
back order is being filled and can be installed. 

If more than one backorder line on the order is being filled only 
one email is sent for the entire order.

An email is sent to all the Installation Managers that have the 
Warehouse/Cost center combination of the order/order lines being 
filled. 

Note: The email is sent to the email address assigned to the 
user via menu option NAV 5 on the green screen. 

Setting Description
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Installers

This part of the Installation Scheduler lets you build a database of installers. 

Setting Description

Team
Assign the Installer to a Team. 

The teams are created vis the Teams tab. 

Installer Installer name.

Supplier Code
Vendor Code

You can cross reference each installation team to the supplier 
and/or vendor codes that represent these teams within accounts 
payable. These codes help you to reconcile the cost of labor to AP. 
When you enter the invoice from the installer into accounts 
payable, the system matches the AP supplier or vendor to the 
cross-referenced installation team. You can use one or both fields.

Primary Contact Phone
Secondary Contact Phone

Enter the phone numbers for the installer. 
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Install Cost Centers

Enter the cost centers that the installer works with. 

If the field is left blank, the system assumes that this installer can 
handle all cost centers.

Home Warehouses

Enter the warehouse codes that this installation team can work 
from. If you enter warehouse codes, the installation team is only 
assigned jobs from those warehouses. These warehouses are 
compared to the header warehouse of each order.

Leave the fields blank to allow this installation team for all your 
warehouses.

Workload Capacity

Day of the Week Enter the days that the installer is usually available.

Start/End Time
Max Hours

The normal working hours for the installation team. The team is 
not available before or after these hours.

Max Hours

This is the maximum number of hours this team is available on this 
particular day.

The installation scheduling program looks at the assigned hours on 
each scheduled line item of an order, plus the assigned hours of 
orders already scheduled, and compares that to the number of Max 
Hours allowed.

Setting Description



February 27, 2017

Service/ Interest Charge Details (Spec 
5092)

Status: AR Service Charge Method B

Date Released: Feb 2017

Modules: AR Navigator and DES reports Apply Interest/Service Charges Mid-Month and Reprint 
Interest/Service Charge Invoices. 

Description: Display the invoices and amounts that are responsible for additional charges. 

Reason for Change: Allows more visibility into how/why additional charges are applied. 

Restrictions This functionality only applies to Method B of applying interest. Method B, as assigned 
in the Company Settings File (SET 3), creates actual service fee invoices as part of the AR end of 
month close.

System Wide Setting - Accounts Receivable Options

The option Print supporting details on invoices in Method B activates this functionality. 

Running the Interest Reports

The following reports show interest:
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• Apply Interest/Service Charges Mid-Month - This report is used to apply interest or services 
charges at a mid-month interval. 

• Reprint Interest/Service Charge Invoices - This option lets you to reprint interest/service 
charge invoices still shown in the A/R History File.

The reports are accessed in the Accounts Receivable grouping of Navigator reports. 

Note: The reports can also be run from the green screen option RAR 201 and RAR 202. 

Select one of the reports. In this example Apply Interest/Service Charges Mid-Month was selected. 
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Ensure the Apply Interest/Service Charges setting is set to “B” and run the report. 

When the report is run, four separate reports are generated. Open the INTINVC/L report to display the 
details/invoices behind any service/interest charge. 
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Disallow Manual Pricing in Navigator 
(Spec 5272)

Status: Navigator Order Management

Date Released: March 2017

Modules: Navigator Order Management

Description: A new permission option has been added to the Order Management Application 
window that grants or denies permission to manually change pricing. This setting 

Our objective with this enhancement is to have a setting that disallows manual pricing at any point in 
the order process. All pricing other than list price would be determined by existing price lists, price 
exceptions and marketing programs; no “pricing on the fly” at time of order. 

Also included in this enhancement, are options to reset pricing at the line and order level to default 
pricing. 

Reason for Change: Establish a rigid pricing structure that does not allow for “ad hoc” pricing. 
Thereby, creating accurate price lists for customers and sales reports for vendors. 

Expected benefits include:

— reduced labor (for pricing corrections), 

— happier customers due to billing accuracy, 

— less complicated order entry 

— increased accuracy for new customer service personnel

— Ability to give customers promotional pricing via the Recalculate Price options

Restrictions: Only applicable to Navigator

Set-up

Order Management Permissons

The new setting, Allow Price Overrides, is accessed via the Order Management - Work with 
Application Permissions screen. 

You can grant or deny manual pricing override authority at the Global Level (NAV 1), the Authority 
Class Level (NAV 2) or the User Level (NAV 5). 



February 27, 2017

Use the “A” App Options/Permissions option to gain access to the setting. 

Grant or deny authority as needed. 

Manually Changing Lines in Navigator

The following windows have been modified to exclude price overrides if the user if not permitted to 
manually override pricing in Navigator Order Management. 

— Add Line and Edit Line - The price fields are protected and cannot be edited.

— Bill Of Material /KIT Item Window - The pricing fields are removed. 

— Inventory Analysis - The Price Override field is removed. 
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— ISO Confirmation - The Price Override field is removed. 

— Price Analysis and Discount Calculator - Price adjustment fields are removed and an error 
message is displayed. 

Recalculate Line/Order Pricing

A new option, Recalculate Order Prices, has been added at the Line and Order level to allow for 
Price Recalculation. 

These options reset pricing to the “default” pricing at either the line or order level. 

Note: Default Pricing takes in account pricing and fund promotions, points, terms and other 
pricing strategies.

Notes:

— at the line level - only available in Order Edit.

— Available regardless of user authority based on the new setting; Allow Price Overrides. 

— Only works for open lines

— Not available for canceled or closed lines (lines in # status).

— A notepad entry is made indicating a line/order price recalculation was performed. 

Line Level 

The new option is accessed via the Line options arrow. 
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Order Level

Accessed via the Available Options drop down. 
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